
 Learning Objectives
After completing this chapter, you will be able to:
• Create particle systems 
• Create space warps
• Understand Mesher compound object
• Understand blobmesh compound object

Particle Systems 
and Space Warps-I
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INTRODUCTION
In 3ds Max, the particle systems are used to create an object that generates other objects 
known as particles. These particles are used to simulate snow, dust, rain, and so on. You can 
also animate the particles in a particle system. 

PARTICLE SYSTEM
To create a particle system, choose Create > Geometry in the Command Panel; a drop-down 
list will be displayed below the Geometry button. Select Particle Systems from the drop-down 
list; the Object Type rollout containing all tools to create the particle system will be displayed, 
as shown in Figure 18-1. In this chapter, you will learn to create and modify different types of 
particle systems using these tools.

Spray Particle System
 Menu bar: 	 	 Create > Particles > Spray			    
 Command Panel:	 Create > Geometry > Particle Systems > 	  
			   Object Type rollout > Spray			 

The Spray particle system is used to generate the particles that are similar to the water drops 
or spray, as shown in Figure 18-2. To create the spray particle system, choose the Spray tool 
from Create > Geometry > Particle Systems > Object Type rollout in the Command Panel; 
the Name and Color and Parameters rollouts will be displayed. In the Top viewport, press and 
hold the left mouse button, and then drag the cursor from one point to another; a rectangular 
shape will be created that is known as emitter. The emitter will not be visible during rendering. 
Choose the Play Animation button from the animation playback controls; the particles will 
start emitting from the emitter, refer to Figure 18-3. The straight line passing through the 
center of the emitter specifies the direction of the particles. If you create the emitter in the 
Front or the Left viewport, then the direction of the particles will be different. After creating 
the emitter, you need to set the size, shape, number, and other properties of the particles in 
the Parameters rollout, which are discussed next.

 Figure 18-2  The Spray particle 
system 

 Figure 18-1  Various tools displayed 
to create particle systems 
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Parameters Rollout
This rollout is used to modify the size, shape, number, and other properties of the spray 
particles. To display this rollout, select the emitter in the viewport and choose the Modify tab 
in the Command Panel; the Parameters rollout will be displayed. The different areas of this 
rollout that are used to modify the properties of the particles are discussed next.

 Figure 18-3  The emitter displayed in all viewports for the Spray particle system

Particles Area  
The options in this area are used to define how the particles 
will be generated, refer to Figure 18-4. Set the value in 
the Viewport Count spinner to define the number of 
particles per frame displayed in the viewport. Set the value 
in the Render Count spinner to define the number of 
particles displayed per frame on rendering. Set the value 
in the Drop Size spinner to modify the size of the particles. 
Set the value in the Speed spinner to define the initial 
velocity of the particles when they leave the emitter. The 
velocity is known as the distance traveled per unit time. 

 Figure 18-4  The Particles 
area in the Parameters rollout

The particles remain at the same speed unless they are affected by a space warp. You will 
learn more about space warps later in this chapter. Set the value in the Variation spinner 
to define the variation in the speed and direction of the particles. As you increase the 
value in the Variation spinner, the particles will get wider and stronger. 

By default, the Drops radio button is selected in this area. As a result, the particles are 
displayed in the shape of drops in the viewports. Select the Dots or Ticks radio button to 
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display the particles in the shape of dots or ticks. These radio buttons do not affect the 
shape of the particles at rendering.

Render Area
This area is used to define the shape of the particles on rendering, refer to Figure 18-5. 
By default, the Tetrahedron radio button is selected in this area. As a result, the particles 
are displayed as tetrahedrons. Select the Facing radio button to display the particles as 
square faces.

Timing Area
The options in this area are used to define the lifetime of the particles, refer to Figure 18-6. 
The value in the Start spinner specifies the frame number at which the emitter will start 
generating the particles. The value in the Life spinner shows the life span of the particles 
in terms of the number of frames. The value in the Birth Rate spinner shows the number 
of new particles generated at each frame. By default, this spinner is not activated. To 
activate this spinner, you need to clear the Constant check box. 

Emitter Area
This area is used to define the dimensions of the emitter, refer to Figure 18-7. Set the 
value in the Width and Length spinners to define the width and length, respectively of 
the emitter. Select the Hide check box to hide the emitter in the viewports. 

 Figure 18-7  The Emitter 
area

 Figure 18-6  The Timing area Figure 18-5  The Render area

Snow Particle System
  Menu bar:	 	 Create > Particles > Snow			    
  Command Panel:	 Create > Geometry > Particle Systems >		  
			   Object Type rollout > Snow			 

The Snow particle system is used to generate the particles that are 

 Figure 18-8  The snow 
particles on rendering

similar to snow flakes, as shown in Figure 18-8. To create the snow 
particle system, choose the Snow  tool from Create > 
Geometry > Particle Systems > Object Type rollout in the 
Command Panel; the Name and Color and Parameters rollouts will 
be displayed. In the Top viewport, press and hold the left mouse 
button, and then drag the cursor from one point to another; the 
emitter will be created. Choose the Play Animation button; the 
particles will start emitting from the emitter, as shown in Figure 18-9. 
After creating the emitter, you need to set the size, shape, number, 
and other properties of the particles in the Parameters rollout, the 
method to set these properties is discussed next.
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 Figure 18-9  The particles displayed in all viewports for the Snow particle system

Parameters Rollout
This rollout is used to modify the size, shape, number, and other properties of the snow 
particles. To display this rollout, select the emitter in the viewport and choose the Modify tab 
in the Command Panel; the Parameters rollout will be displayed. In the Parameters rollout, 
most of the options are the same as discussed in the spray particle system. The remaining 
options are discussed next.
	

Particles Area
The Flake Size spinner in this area is used to specify the size of the particles. Set a value 
in the Tumble spinner to specify the amount of random rotation of the snow particles. 
Set the value in the Tumble Rate spinner to specify the speed of rotation of the snow 
particles. As you increase the value in the Tumble Rate spinner, the speed of rotation 
also increase. 

Render Area
By default, the Six Point radio button is selected in this area. As a result, the particles are 
displayed as six point shape on rendering, refer to Figure 18-8. Select the Triangle or  
Facing radio button to display the triangular or facing particles at rendering, as shown 
in Figures 18-10 and 18-11.     



18-6				                Autodesk 3ds Max 2015: A Comprehensive Guide

 Figure 18-11  The facing snow particles  Figure 18-10  The triangular snow particles

Super Spray Particle System
  Menu bar:	 	 Create > Particles > Super Spray	    
  Command Panel:	 Create > Geometry > Particle Systems >	   
			   Object Type rollout > Super Spray	   

The Super Spray particle system is the advanced version of the Spray particle system. To create 
the Super Spray particle system, you need to choose the Super Spray tool from Create > 
Geometry > Particle Systems > Object Type rollout in the Command Panel; the Name and 
Color, Basic Parameters, Particle Generation, Particle Type, Rotation and Collision, Object 
Motion Inheritance, Bubble Motion, Particle Spawn, and Load/Save Presets rollouts will be 
displayed. In the Top viewport, press and hold the left mouse button, and then drag the cursor 
from one point to another; the emitter will be created. Choose the Play Animation button; 
the particles will start emitting from the emitter, as shown in Figure 18-12.

 Figure 18-12  The particles generated for the Super Spray particle system
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After creating the emitter, you need to set the size, shape, number, and other properties of the 
particles in various rollouts. The most commonly used rollouts are discussed next.

Basic Parameters Rollout
The options in this rollout are used to define the direction, spread, and other properties of 
the particles, refer to Figure 18-13. The areas in this rollout are discussed next. 

Particle Formation Area
Set the value in the Off Axis spinner to offset the angle of the 

 Figure 18-13  The Basic 
Parameters rollout

particles in the Z-axis. Set the value in the Spread spinner to 
spread the particles away from the emitter. Set the value in the 
Off Plane spinner to offset the direction of particles in the 
horizontal plane. The value in the Spread spinner is used to 
spread the particles around the off plane axis. 

Note 
If you set the value 0 in the Off Axis spinner, then the value in 
the Off Plane spinner will not affect the particles.   

Display Icon Area
Set the value in the Icon Size spinner to define the size of the 
emitter icon in the viewport. Select the Emitter Hidden check 
box to hide the emitter icon in the viewport. 

Viewport Display Area
The radio buttons in this area are used to define the shape of 
the particles in the viewport. Set the value in the Percentage 
of Particles spinner to define the percentage of the number of 
particles to be displayed in the viewport. 

Particle Generation Rollout
The options in this rollout are used to define the motion, quantity, 

 Figure 18-14  Partial view of the 
Particle Generation rollout

size, and other properties of the particles, refer to Figure 18-14. 
The areas in this rollout are discussed next.

Particle Quantity Area
The radio buttons in this area are used to define how the 
particles will be generated over the time. By default, the 
Use Rate radio button is selected. It is used to define the 
number of particles generated at each frame. The spinner 
below this radio button defines the number of particles 
created per frame. Select the Use Total radio button to 
define the total number of particles generated over the 
life span of the system. Set the value in the spinner below 
this radio button to define the total number of particles 
created over the life span of the system.
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Particle Motion Area
The options in this area are used to define the speed of the particles. Set the value in the 
Speed spinner to specify the initial velocity of the particles when they leave the emitter. Set 
the value in the Variation spinner to specify the variation in the speed and the direction 
of the particles. 

Particle Timing Area
In the Emit Start and Emit Stop spinners, set the frame number at which the particles 
will begin and stop the emission. Set the value in the Display Until spinner to define 
the frame number at which all particles will disappear from the scene. The value in the 
Life spinner specifies the life span of the particles in terms of the number of frames. The 
value in the Variation spinner is used to define the number of frames by which the life of 
the particles can vary randomly.

Particle Size Area
The options in this area are used to define the size of the particles. 

 Figure 18-15  Partial view 
of the Particle Type rollout

Set the value in the Size spinner to specify the size of the 
particles. The value in the Variation spinner is used to define 
the variation in the size of the particles. The value in the Grow 
For spinner is used to define the number of frames in which 
the particles will grow from their original size to the size 
specified in the Size spinner. The value in the Fade For spinner 
is used to define the number of frames in which the particles 
will shrink to 1/10th of their size before their death.     
   	

Particle Type Rollout
The options in this rollout are used to define the type of particles 
used in the scene, refer to Figure 18-15. The areas in this rollout 
are discussed next.  

Particle Types Area
The radio buttons in this rollout are used to define the type of geometry of the 
particles on rendering. When you select a radio button in the Particle Types area, 
its corresponding area will get activated in the rollout where you can modify the 
parameters as per your requirement. By default, the Standard Particles radio button is 
selected, and therefore, the Standard Particles area is activated. There are eight types of 
radio buttons such as Cube, Tetra, Facing, and so on in this area to define the geometry 
of the particles. Select the corresponding radio button to change the geometry of the 
particles at rendering. 

Note
You cannot view the change in the geometry of the particles in the viewport. It will be displayed 
only after rendering.      

Select the MetaParticles radio button in the Particle Types area; the MetaParticle 
Parameters area will be activated. The options in this area are used to create the particles 
in the form of metaballs. The metaball particles can join together to form a blob or a 
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stream of particles. The blob is an indistinct form of particles, refer to Figure 18-16. You 
can modify the parameters of the meta particles in the MetaParticle Parameters area. 

Select the Instanced Geometry radio button in the Particle Types area; the Instancing 
Parameters area will be activated. This area is used to select an object in the viewport to 
be used as particles in a particle system. These particles will be the instance of the object. 
To create an instance of the object, choose the Pick Object button in the Instancing 
Parameters area and select the object in the viewport; the particles will take the geometry 
of the selected object and they will be displayed on rendering, refer to Figure 18-17.  

 Figure 18-16  The meta particles  Figure 18-17  The torus object selected 
to create the instance particles 

          

Mat’l Mapping and Source Area
The options in this area are used to define the material and the mapping for the 
particles.

Rotation and Collision Rollout
The options in this rollout are used to rotate the particles and add motion blur to them, refer 
to  Figure 18-18. The motion blur is used to provide the blur effect to the fast moving animated 
objects to make them look more realistic. The areas in this rollout are discussed next.

Spin Speed Controls Area
The value in the Spin Time spinner specifies the total

 Figure 18-18  Partial view of the 
Rotation and Collision rollout

 
number of frames that the particles will take to complete 
one rotation. Set the value in the Variation spinner to set 
the percentage of variation of the spin time. The value in 
the Phase spinner is used to define the initial rotation of 
the particles at birth. Set the value in the Variation spinner 
below the Phase spinner to specify the percentage of 
variation of phase.

Spin Axis Controls Area
The options in this area are used to set the axis of rotation 
for the particles. By default, the Random radio button is 
selected that is used to define the axis of rotation for each particle randomly. On selecting 
the Direction of Travel/Mblur radio button, the particles will rotate about a vector formed 
in the direction of the movement of the particles. In the Stretch spinner, set the value in 
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percentage to stretch each particle. The Direction of Travel/Mblur radio button is also 
used to apply the motion blur to the object. Select the User Defined radio button to use 
a vector for the rotation that is defined in the X Axis, Y Axis, and Z Axis spinners. 

Interparticle Collisions Area           
This area is used to control the collisions between the particles.  

Object Motion Inheritance Rollout
The spinners in this rollout are used to specify the extent by which the motion of particles will 
be affected by the motion of the emitter. These options are discussed next.

Influence Spinner 
	 The Influence spinner is used to specify the percentage of particles that inherit the motion 

of the object-based emitter at the moment of particle formation.

Multiplier Spinner
The Multiplier spinner is used to specify the extent upto which the emitter motion affects 
the particle motion. This can be a positive or negative number.

Variation Spinner
The Variation spinner is used to specify the percentage of variation of the Multiplier 
spinner.

Bubble Motion Rollout           
The options in this rollout are used to provide a waveform motion path for the particles, refer to 
Figure 18-19. This rollout is also used to produce a wobbling effect in the particles. Set the value 
in the Amplitude spinner to specify the height of each wave. The value in the Period spinner 
is used to define the number of frames it takes to complete one cycle of the wave. The value in 
the Phase spinner specifies the initial position of a particle along the wave. Set the values in 
different Variation spinners to produce variations in the corresponding parameters.  

Particle Spawn Rollout
The options in this rollout are used to specify the reaction of the particles when they die 
or collide with a particle deflector, refer to Figure 18-20. A deflector is a space warp about 
which you will learn later in this chapter. The most commonly used areas of this rollout are 
discussed next.

Particle Spawning Effects Area 
By default, the None radio button is selected and therefore particles will not spawn. The 
properties of the deflector objects set the nature of particles on collision. On selecting 
the Die After Collision radio button, the particles disappear after colliding with the 
deflector object. Also, the Persist and Variation spinners get activated. Set the value in 
the Persist spinner to specify the number of frames, in which the particles remain alive 
after the collision. 
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 Figure 18-20  The Particle Spawn rollout Figure 18-19  The Bubble Motion rollout

If you select the Spawn on Collision radio button, the particles will be generated after the 
collision. Whereas on selecting the Spawn on Death radio button, the particles will spawn 
at the end of their life span. On selecting the Spawn Trails radio button, the particles 
will spawn from each existing particle at each frame of the particles’ life. Set the values 
in the Spawns, Affects, Multiplier, and Variation spinners to modify the spawn of the 
particles.

Direction Chaos Area
Set the value in the Chaos spinner in this area to vary the direction of the spawned 
particles.

Speed Chaos Area
Set the values in different options of this area to vary the speed of the spawned 
particles.

Scale Chaos Area
Set the values in different options of this area to scale the spawned particles.

Lifespan Value Queue Area
The options in this area are used to specify a list of alternative lifespan values for each 
spawned particles. 

Object Mutation Queue Area
The options in this area are used to switch between instanced-object particles with each 
spawning. These options are available only if the Instanced Geometry radio button is 
selected in the Particle Type rollout. 

Load/Save Presets Rollout
The options in this rollout are used to load the predefined settings of the particle system, 
refer to Figure 18-21. You can save these settings to use in other particle systems. On the top 
of this rollout, enter a name for the settings in the Preset Name text box and choose the Save 
button; the name of the settings will be displayed in the list box given in the Saved Presets 
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area. If you need to use the same settings for another particle system, 

 Figure 18-21  The Load/
Save Presets rollout

then select the new particle system in the viewport and select the 
name of the settings from the list box in the Saved Presets area. 
Now, choose the Load button; the same settings will be applied to 
the new particle system. 

To delete the settings, select the name of the settings in the Saved 
Presets area, and then choose the Delete button. You can also use the 
default settings available in the list box such as Bubbles, Fireworks, 
and so on in the Saved Presets area. 

Blizzard Particle System 
  Menu bar:	 	 Create > Particles > Blizzard	               
  Command Panel:	 Create > Geometry > Particle Systems >	                                                                   
			   Object Type rollout > Blizzard		    

The Blizzard particle system is the advanced version of the Snow particle system. To 
create the Blizzard particle system, choose the Blizzard tool from Create > Geometry > 
Particle Systems > Object Type rollout in the Command Panel; the Name and Color, 
Basic Parameters, Particle Generation, Particle Type, Rotation and Collision, Object Motion 
Inheritance, Particle Spawn, and Load/Save Presets rollouts will be displayed. In the Top 
viewport, press and hold the left mouse button, and then drag the cursor from one point to 
another; the emitter will be created. Choose the Play Animation button; the particles will 
emit from the emitter, as shown in Figure 18-22. After creating the emitter, you need to set 
the properties of the particles in various rollouts. The options in the rollouts are the same as 
discussed in the Super Spray particle system. However, the main difference is that in the Basic 
Parameters rollout of the Blizzard particle system, you need to set the width and length of 
the emitter icon in their respective spinners in the Display Icon area.  

 Figure 18-22  The particles generated for the Blizzard particle system
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PArray Particle System 
  Menu bar:	 	 Create > Particles > PArray		     
  Command Panel:	 Create > Geometry > Particle Systems >	   
			   Object Type rollout > PArray		    

The PArray particle system is used to generate particles from the selected geometry. Moreover, 
it is used to create an explosion of the objects. In the PArray particle system, the geometry that 
you use to emit the particles becomes the emitter and is referred to as the distribution object. 
To create the PArray particle system, first you need to create a geometry in the viewport and 
then choose the PArray tool from Create > Geometry > Particle Systems > Object Type 
rollout in the Command Panel; the Name and Color, Basic Parameters, Particle Generation, 
Particle Type, Rotation and Collision, Object Motion Inheritance, Particle Spawn, Bubble 
Motion, and Load/Save Presets rollouts will be displayed. In the Top viewport, press and 
hold the left mouse button, and then drag the cursor to create the PArray particle system. 
Next, in the Basic Parameters rollout, choose the Pick Object button, move the cursor over 
the geometry that you want to use as the distribution object or the emitter, and then select 
the geometry; the selected geometry will act as the distribution object. Now, choose the Play 
Animation button; the particles will emit from the selected geometry, as shown in Figure 18-23. 
Now, you need to set the properties of the particles in various rollouts. Most of the options 
in the rollouts displayed are same as those discussed in the Super Spray particle system. The 
remaining ones are discussed next.

 Figure 18-23  The particles generated from the distribution object (teapot) in viewports

Basic Parameters Rollout
The options in this rollout are used to define the distribution object and set the properties of 
the PArray particle system, refer to Figure 18-24. The Pick Object button in the Object-Based 
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Emitter area is used to select a geometry in the viewport to use it as the distribution object. 
The Particle Formation area is discussed next.

Particle Formation Area      	
The options in this area are used to define how the particles will be distributed over the 
surface of the distribution object. By default, the Over Entire Surface radio button is 
selected that is used to emit the particles over the entire surface of the distribution object. 
Select the Along Visible Edges radio button to emit the particles randomly from the 
visible edges of the distribution object. Select the At All Vertices radio button to emit the 
particles from the vertices of the distribution object. On selecting the At Distinct Points 
radio button, the Total spinner will get activated. Set the value in this spinner to specify 
the number of points over the surface of the distribution object, from which the particles 
will be emitted. Select the At Face Centers radio button to emit the particles from the 
center of each triangular face. Select the Use Selected SubObjects check box to emit the 
particles from the selected sub-object of the distribution object. 

Particle Generation Rollout
The options in this rollout are the same as those discussed in the Super Spray particle system. 
In the Particle Motion area, set the value in the Divergence spinner to vary the direction of 
the particles in degrees.

Particle Type Rollout   
The options in this rollout are used to specify the particle type and the type of mapping 
performed on the particles. On selecting the Object Fragments radio button in the Particle 
Types area of this rollout, the Object Fragment Controls area will get activated. The options 
in this area are used to generate the particles from the fragments of the distribution object, 
as shown in Figure 18-25. Also, you can use this option to create an explosion of an object. 
Set the value in the Thickness spinner in the Object Fragment Controls area to specify the 
thickness of the fragments. By default, the All Faces radio button is selected, therefore, all 
faces of the selected object turn into fragments. Select the Number of Chunks radio button 
to break the object into irregular fragments. Set the value in the Minimum spinner to specify 
the minimum number of fragments that will be generated. Select the Smoothing Angle radio 
button to break the object based on the angle between the face normals. 

 Figure 18-25  The PArray particle system 
with the Object Fragments particle type

 Figure 18-24  Partial view of 
the Basic Parameters rollout
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PCloud Particle System                  
  Menu bar:	 	  Create > Particles > PCloud					      
  Command Panel:	  Create > Geometry > Particle Systems > Object Type > PCloud	

The PCloud particle system is used to create the particles that will be enclosed in 
a specific volume. To create the PCloud particle system, choose the PCloud tool 
from Create > Geometry > Particle Systems > Object Type rollout in the Command Panel; 
the Name and Color, Basic Parameters, Particle Generation, Particle Type, Rotation and 
Collision, Object Motion Inheritance, Particle Spawn, Bubble Motion, and Load/Save 
Presets rollouts will be displayed. In the Top viewport, press and hold the left mouse button, 
drag the cursor from one point to another, and then release the left mouse button. Move the 
cursor up or down to specify the height of the emitter and then click on the screen; an emitter 
will be created, as shown in Figure 18-26. Next, you need to set the properties of the particles 
in various rollouts. Most of the options in the rollouts are the same as discussed in the Super 
Spray particle system. The others options are discussed next. 

 Figure 18-26  The emitter created for the PCloud particle system 

Basic Parameters Rollout
The radio buttons in the Particle Formation area of this rollout are used to define the shape of 
the emitter icon, refer to Figure 18-27. By default, the Box Emitter radio button is selected and 
it is used to display a box shape emitter. Select the Sphere or Cylinder Emitter radio button 
to display a spherical or a cylindrical shape emitter. If you use the geometry in the viewport 
as the distribution object, then the Object-based Emitter radio button will automatically get 
selected.
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Particle Generation Rollout
In the Particle Motion area of this rollout, there are some additional options to define the 
path of the particles, refer to Figure 18-28. By default, the Random Direction radio button 
is selected. It is used to emit the particles from the emitter in random directions. Select the 
Direction Vector radio button; the X, Y, and Z spinners will get activated. Set the value in 
these spinners to specify the direction of the particles along a vector. Select the Reference 
Object radio button to emit the particles along a vector defined by the local Z-axis of the 
selected object. Choose the Pick Object button to select an object. Set the value in the Variation 
spinner to vary the direction of the particles in percentage.

 Figure 18-27  The Particle Formation 
area in the Basic Parameters rollout

 Figure 18-28  The Particle Motion area 
in the Particle Generation rollout

In the next section, you will learn to create the blobmesh and mesher compound objects with 
the help of various particle systems.

BLOBMESH   
  Menu bar:	 	 Create > Compound > BlobMesh		   
  Command Panel:	 Create > Geometry > Compound Objects > 	  
			   Object Type rollout > BlobMesh			 

The BlobMesh tool is used to create metaballs based on the object selected in the viewport. 
These metaballs create the blobmesh objects that can flow, such as the thick liquids and the soft 
objects. A metaball is a type of sphere that connects itself to another object within a particular 
distance using a connecting surface. Therefore, a blobmesh compound object will generate 
the metaballs and then connect the spheres together to create the effect of thick liquid and so 
on. If the particles are in a certain range, they will connect together to give the effect of liquid. 
On moving the particles apart, they will unite again to take the spherical shape.           

You can create a blobmesh compound object from any geometry or particle system. To 
create the blobmesh object using the particle system, first create a particle system as discussed 
earlier in this chapter, and set its parameters in the rollouts available in the Modify panel. 
Next, choose Create > Geometry in the Command Panel; a drop-down list will be displayed 
below the Geometry button. Select the Compound Objects option from the list; the Object 
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Type rollout will be displayed. Choose the BlobMesh tool and click anywhere on the screen; a 
metaball will be created. Next, choose the Modify tab in the Command Panel; the Parameters 
rollout will be displayed, where you can specify the parameters to modify the metaball; refer 
to Figure 18-29. In the Blob Objects area of the Parameters rollout, choose the Add button; 
the Add Blobs dialog box will be displayed. Select the particle system from the list displayed 
in this dialog box and choose the Add Blobs button; the metaball will be displayed at each 
particle of the particle system. You can apply material to the blobmesh object to get the realistic 
effect, as shown in Figure 18-30. Also, you need to set the values in the Parameters rollout to 
get the desired effect.    

 Figure 18-29  The Parameters rollout  Figure 18-30  The BlobMesh object created 
from the blob mesh compound object 

MESHER 
  Menu bar:	 	 Create > Compound > Mesher			    
  Command Panel:	 Create > Geometry > Compound Objects >	  
			   Object Type rollout > Mesher	   		

The Mesher tool is used to create instances of the animated objects. This tool has been mainly 
designed to be used with the particle systems. Moreover, you can use it with any object. You 
can also apply the modifiers to a particle system using the mesher compound object.           

To create a mesher object, first create a particle system and then set its parameters 
as per your need. Next, choose Create > Geometry in the Command Panel; a drop-down list 
will be displayed below the Geometry button. Select the Compound Objects from the list; the 
Object Type rollout will be displayed. Choose the Mesher tool in this rollout and drag the 
cursor from one place to another in the Top viewport; a pyramid shape will be created, as shown 
in Figure 18-31. Next, choose the Modify tab in the Command Panel; the Parameters rollout 
will be displayed, as shown in Figure 18-32. In the Parameters rollout, choose the Pick Object 
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button labeled as None, and then select the particle system in the viewport; an instance of 
the particle system will be displayed once you play the animation, as shown in Figure 18-33. 
Also, the pyramid shape will disappear. When you play the animation, the instance particle 
system will behave exactly like the original one. You can also assign a modifier to the instanced 
particle system, as shown in Figure 18-34.   

 Figure 18-31  The mesher object in 
the Perspective viewport

 Figure 18-32  The Parameters rollout 

 Figure 18-34  The Bend modifier assigned 
to the instanced particle system

 Figure 18-33  The instance of the particle 
system displayed

Note
The size of the mesher object does not affect the particle system.

INTRODUCTION TO SPACE WARPS
In 3ds Max, the space warps objects cannot be rendered and are used to affect the motion 
and appearance of the other objects. They can generate special effects such as blowing wind, 
flowing waves, and so on in the animation. There are five categories of space warps, Forces, 
Deflectors, Geometric/Deformable, Modifier-Based, and Particles & Dynamics.
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To create a space warp, choose Create > Space Warps in the Command Panel; the 
Forces category will be displayed by default in the drop-down list below the Space 
Warp button. Select another category from the drop-down list, if required; the Object 

Type rollout showing all tools related to the selected category will be displayed, refer to 
Figure 18-35. Next, choose the required space warp tool and drag the cursor in the viewport 
to create the space warp. 

To view the effect of the space warp on the object, you need to bind the object with 
the space warp. To do so, select the object that you want to be affected by the space 
warp in the viewport. Next, choose the Bind to Space Warp tool from the Main Toolbar 

and move the cursor over the selected object in the viewport; the cursor will be displayed, as 
shown in Figure 18-36. Now, click on the object and drag the cursor to the space warp object; 
a dotted line will be displayed from the selected object to the space warp object, as shown in 
Figure 18-37. Release the mouse button; the object will be bound to the space warp object. 
Also, the name of the space warp object will be displayed in the Command Panel to indicate 
that the object is linked to the space warp object, as shown in Figure 18-38. 

 Figure 18-36  The cursor displayed on 
invoking the Bind to Space Warp tool

 Figure 18-35  The Forces category 
selected in the drop-down list 

 Figure 18-37  A dotted line displayed from the 
selected object to the space warp object

 Figure 18-38  The space warp object 
displayed in the Command Panel 

Next, select the space warp object in the viewport and choose the Modify tab in the Command 
Panel; various rollouts will be displayed to modify the parameters of the space warp object. 
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Modify the parameters to create special effects in the object. You can also transform the space 
warp object using the Select and Move, Select and Rotate, and other transforming tools. In 
the Modify tab of each space warp, there is a rollout named as Supports Objects of Type. This 
rollout displays a list of types of objects that you can bind with the selected space warp.    

Note
You can bind multiple objects to a single space warp. In this case, all objects will be equally 
affected by the space warp. Also, you can apply multiple space warps to a single object.    

CATEGORIES OF SPACE WARPS
There are five categories of space warps. Choose Create > Space Warps from the Command 
Panel; a drop-down list will be displayed. You can select the required category from the 
drop-down list. These categories are discussed next.    

Forces
  Menu bar:	 	 Create > SpaceWarps > Forces > Push	  
  Command Panel:	 Create > Space Warps > Forces > 	  
			   Object Type rollout > Push		

The tools in the Forces category are used to create the space warps that generate the effect of 
natural forces on the objects such as push, wind, gravity, and so on. Some of the space warps 
in this category are discussed next.

Push Space Warp
The Push space warp is used to generate a force in the particle 

 Figure 18-39  The effect 
of Push space warp on the 
particle system 

system in a single uniform direction, as shown in Figure 18-39. 
It can be used to create effects such as of blowing wind, cigarette 
smoke, and so on. 

To create a Push space warp in the viewport, choose the Push tool; 
the Name and Color, Supports Objects of Type, and Parameters 
rollouts will be displayed. Next, activate the suitable viewport, 
press and hold the left mouse button, and drag the cursor to create 
the Push space warp; the Push space warp icon will be displayed 
in all viewports. Figure 18-40 displays the Push space warp icon in 
the Perspective viewport. Next, you need to bind the Push space 
warp with the particle system using the Bind to Space Warp tool. 
Also, you need to set the parameters in the Parameters rollout of 
Push space warp to generate the effect. The Parameters rollout 
and its options are discussed next.   

Note
The size of a space warp icon does not affect the particle system.
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Parameters Rollout
The options in this rollout are used to set the effect of the Push space warp on the particle 
system, refer to Figure 18-41. The different areas in this rollout are discussed next.   

 Figure 18-40  The Push space warp icon  Figure 18-41  Partial view 
of the Parameters rollout 
for Push space warp

Timing Area: The options in this area are used to define the number of frames in which 
the effect of Push space warp will start and end. Set the values in the On Time and Off 
Time spinners to set the frame number at which the Push space warp will start and end 
the effect, respectively.

Strength Control Area: Set the value in the Basic Force spinner to specify the strength of 
the force generated by the Push space warp. Select the Newtons or the Pounds radio button 
to define the units of the force. Select the Feedback On check box; the Reversible check 
box, the Target Speed spinner, and the Gain spinner will get activated. The Feedback On 
check box is used to vary the force that depends on the speed of the bounded particles 
relative to the speed in the Target Speed spinner. If the Feedback On check box is cleared, 
the force remains constant. On selecting the Reversible check box, the force is reversed 
if the speed of the particles exceeds the speed in the Target Speed spinner.         

Periodic Variation Area: The options in this area are used to generate variations in the 
strength of the force applied by Push space warp. Select the Enable check box to activate 
the options in this area. Set the values in the Period 1 and Period 2 spinners to set the 
number of frames it takes to complete one cycle of variation in strength of the Push space 
warp. Set the values in the Amplitude 1 and Amplitude 2 spinners to define the strength 
of variation in percentage. Set the values in the Phase 1 and Phase 2 spinners to offset 
the variation pattern.
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Particle Effect Range Area: Select the Enable

 Figure 18-42  The spherical shape of the Push 
space warp

 
check box in this area; a spherical shape will 
be displayed in the viewport, as shown in 
Figure 18-42. Set the value in the Range 
spinner to limit the range of the effect of the 
Push space warp.

Display Icon Area: Set the value in the Icon 
Size spinner to specify the size of the Push 
space warp icon.     

Gravity Space Warp
  Menu bar:	 	 Create > SpaceWarps > Forces > Gravity		  
  Command Panel:	 Create > Space Warps > Forces > 		   
			   Object Type rollout > Gravity			 

The Gravity space warp is used to generate a gravitational force in a particle system toward 
a particular direction. The particles affected by the Gravity space warp will be accelerated in 
the direction of gravity arrow, as shown in Figure 18-43.

 Figure 18-43  The particle system with the Gravity space warp 

To create a Gravity space warp, choose the Gravity tool; the Name and Color, Supports 
Objects of Type, and Parameters rollouts will be displayed. Next, activate the suitable viewport, 
press and hold the left mouse button, and drag the cursor to create the Gravity space warp; 
the Gravity space warp icon will be displayed in all viewports, refer to Figure 18-43.
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Next, bind the Gravity space warp with the particle system and set the parameters in 
the Parameters rollout to generate the desired effect. This rollout is discussed next.
   

Parameters Rollout
The options in this rollout are used to set the effect of the 
Gravity space warp on the particle system, refer to Figure 
18-44. The Force area in this rollout is discussed next.   

Force Area
Set the value in the Strength spinner to set the effect 
of the gravity force on the particle system. As you 
increase the value in the Strength spinner, the effect 
of the gravity force will also be increased. If you set the 
negative value in the Strength spinner, then the particles 
will be affected by the negative gravitational force and 
therefore, they will be repelled from the gravity icon. 
The value in the Decay spinner affects the strength of 
the gravity force. If you increase the value in the Decay spinner, then the effect of the 
gravity force will be decreased. By default, the Planar radio button is selected in this area. 
As a result, the gravitational force will be applied on the particles in a direction that is 
perpendicular to the plane of the Gravity space warp, refer to Figure 18-43. Select the 
Spherical radio button to apply the gravitational force on the particles toward the center 
of the sphere, as shown in Figure 18-45. 

 Figure 18-45  The particle system with the spherical Gravity space warp 

             

 Figure 18-44  The Parameters 
rollout for the Gravity space warp
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Path Follow Space Warp
  Menu bar:	 	 Create > SpaceWarps > Forces > Path Follow	  
  Command Panel:	 Create > Space Warps > Forces >		   
			   Object Type rollout > Path Follow      		

The Path Follow space warp is used to select a spline in the viewport that will be used as a 
path for the particles, refer to Figure 18-46.

 Figure 18-46  The particle system with the Path Follow space warp 

To create a Path Follow space warp, first create a particle system and a spline. Next, choose 
the Path Follow tool; the Name and Color, Supports Objects of Type, and Basic Parameters 
rollouts will be displayed. Next, activate the suitable viewport, press and hold the left mouse 
button, and drag the cursor to create the Path Follow space warp; the Path Follow space warp 
icon will be displayed in all viewports, refer to Figure 18-46. Now, bind the Path Follow space 
warp with the particle system. In the Basic Parameters rollout of the Path Follow space warp, 
choose the Pick Shape Object button and select the spline in the viewport. Next, you need to 
set the other parameters of the Path Follow space warp in the Basic Parameters rollout. This 
rollout and its options are discussed next.

Basic Parameters Rollout
The options in this rollout are used to set the parameters of the Path Follow space warp 
to affect the particles in a desired way, refer to Figure 18-47. The areas in this rollout are 
discussed next.

Current Path Area: The options in this area are used to select the spline path and limit 
the range of effect of the space warp. Choose the Pick Shape Object button to select the 
spline in the viewport.
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Motion Timing Area: Specify the frame numbers at which the Path Follow space warp 
will start and stop affecting the particles in the Start Frame and Last Frame spinners, 
respectively. Set the value in the Travel Time spinner to specify the number of frames in 
which the particles will cross the entire path.       

Particle Motion Area: The options in this area are used to control the motion of the 
particles along the path. The Along Parallel Splines radio button is selected by default. As 
a result, the path followed by the particles will be exactly the same as that of the selected 
spline. On selecting the Along Offset Splines radio button, the motion of the particles will 
be affected by the distance between the particle system and the spline path. The Constant 
Speed check box is used to generate the constant speed for the particles. Set the value in 
the Stream Taper spinner to specify the amount of the stream of the particles that will be 
tapered along the path, as shown in Figure 18-48. Set the value in the Variation spinner 
to specify the amount of deviation of the particles from the taper value. Set the value in 
the Stream Swirl spinner to specify the number of turns that the particles will take around 
the path, as shown in Figure 18-49. Set the value in the Variation spinner to specify the 
deviation of the particles from the swirl value. 

 Figure 18-48  The particles 
with the stream taper effect

 Figure 18-49  The particles 
with the stream swirl effect

 Figure 18-47  Partial view of the 
Basic Parameters rollout 

Wind Space Warp
  Menu bar:	 	 Create > SpaceWarps > Forces > Wind				     
  Command Panel:	 Create > Space Warps > Forces > Object Type rollout > Wind	

The Wind space warp is used to generate the blowing wind effect in a particle system, refer 
to Figure 18-50. The Wind space warp is very similar to the Gravity space warp. The only 
difference is that the Wind space warp has the additional turbulence effect, which gives a 
realistic view to the particle system.    
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 Figure 18-50  The effect of the Wind space warp on the particle system

To create a Wind space warp, choose the Wind tool; the Name and Color, Supports Objects 
of Type, and Parameters rollouts will be displayed. Next, activate the suitable viewport, press 
and hold the left mouse button, and drag the cursor to create the Wind space warp; the Wind 
space warp icon will be displayed in all viewports, refer to Figure 18-50. Next, bind the Wind 
space warp with the particle system and set the parameters in the Parameters rollout to 
generate a realistic effect. This rollout is discussed next. 

Parameters Rollout  
The options in the Force and Display areas are the same as 

 Figure 18-51  The Wind area 
in the Parameters rollout 

those discussed in the Gravity space warp. The Wind area, 
as shown in Figure 18-51, is discussed next.

Wind Area: Set the value in the Turbulence spinner to create 
random variations in the flow of particles when the Wind 
space warp blows them. The value in the Frequency spinner 
is used to define how the turbulence will vary over the time. 
Set the value in the Scale spinner to scale the turbulence effect.  

PBomb Space Warp
  Menu bar:	 	 Create > SpaceWarps > Forces > PBomb		      		   
  Command Panel:	 Create > Space Warps > Forces > Object Type rollout > PBomb	     

The PBomb space warp is used to explode a particle system, refer to Figure 18-52. The PBomb 
space warp is mostly used with the PArray particle system. 
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To use the PBomb space warp, first create an object that you want to 

Figure 18-52  The effect of the 
PBomb space warp on a sphere
at a single frame at rendering

explode. To do so, choose the PArray tool from Create > 
Geometry > Particle Systems > Object Type rollout and then 
create a PArray particle system in the viewport. Next, choose 
the Pick Object button in the Basic Parameters rollout of the 
PArray particle system and select the object that you have 
created. In the Particle Type rollout of this particle system, 
select the Object Fragments radio button and set the other 
parameters. Next, choose the PBomb tool from Create > Space 
Warps > Forces > Object Type rollout in the Command 
Panel; the Name and Color, Supports Objects of Type, and 
Basic Parameters rollouts will be displayed. Press and hold the 
left mouse button and drag the cursor in the viewport to create the PBomb space warp; the 
PBomb space warp icon will be displayed in all viewports, as shown in Figure 18-53. 

 Figure 18-53  The PBomb space warp icon in the viewport 

Next, bind the PBomb space warp with the PArray icon and set the parameters in the Basic 
Parameters rollout to generate a realistic effect. The Basic Parameters rollout is discussed 
next. 

Basic Parameters Rollout
The options in this rollout are used to modify the parameters of the PBomb space warp, 
refer to Figure 18-54. The areas in this rollout are discussed next.

Blast Symmetry Area: By default, the Spherical radio button is selected. As a result, the 
force is applied outward from the PBomb icon in all directions, refer to Figure 18-52. 
Select the Cylindrical radio button; the PBomb icon will change to a cylindrical shape, 
refer to Figure 18-55. The Cylindrical radio button is used to apply the force outward in 
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a cylindrical form from the PBomb icon, as shown in Figure 18-56. Select the Planar radio 
button; the PBomb icon will change to a plane with arrows in it, as shown in Figure 18-57. 
The Planar radio button is used to apply the force outward from the PBomb icon, 
perpendicular to the plane. 

 Figure 18-55  The PBomb icon after 
selecting the Cylindrical radio button 

 Figure 18-54  The Basic 
Parameters rollout for the 
PBomb space warp

 Figure 18-56  The effect of the PBomb 
space warp on a sphere after selecting the 
Cylindrical radio button at rendering 

 Figure 18-57  The PBomb icon after 
selecting the Planar radio button 

Explosion Parameters Area: Set the value in the Start Time spinner to specify the frame 
number at which the explosion will start. Set the value in the Duration spinner to specify 
the number of frames over which the forces will be assigned. Set the value in the Strength 
spinner to specify the strength of the force.   
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 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:                                                                                                                                

1.	 Which of the following tools is used create the particle system that generates particles 
similar to the water drops or spray?

	
		  (a) Spray				    (b) Blizzard
		  (c) Snow	 			   (d) PCloud

2.	 Which of the following is a category of the space warps?

		  (a) Forces		  		  (b) Geometric/Deformable	
		  (c) Deflectors 				    (d) All of these	

3.	 Which of the following rollouts in the Super Spray particle system is used to load the 
settings that you can use further in other particle systems?

		  (a) Particle Spawn	 		  (b) Bubble Motion		
		  (c) Load/Save Presets			   (d) Particle Type

4.	 Which of the following tools is used to create the space warps that generate the effect of 
natural forces on objects?

	
		  (a) Push				    (b) Gravity
		  (c) Path Follow	 			   (d) All of these

5.	 You can view the emitter of any particle system on rendering. (T/F)	

6.	 The options in the Particle Motion area of the Super Spray particle system are used to 
define the speed of the particles. (T/F)

7.	 The space warp objects are used to affect the motion and appearance of other 
objects. (T/F)

8.	 A __________ is a type of spherical shape that connects itself to another object within a 
particular distance using a connecting surface.

9.	 The __________ tool is used to bind the object with the space warp object.

10.	 The __________ particle system is used to create a fountain.
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 Review Questions 
Answer the following questions:

1.	 Which of the following space warps is used to generate a gravitational force in a particle 
system in a particular direction? 

		  (a) Push		 			   (b) Path Follow
		  (c) Gravity		  		  (d) Wind

2.	 Which of the following space warps is used to explode a particle system?

		  (a) Gravity	 			   (b) Wind
		  (c) Push					    (d) PBomb

3.	 Which of the following space warps is used to select a spline in the viewport to use as a 
path for the particles? 

		  (a) Wind		  		  (b) Displace
		  (c) Path Follow	 			   (d) PBomb

4.	 Which of the following options in the Basic Parameters rollout of the PBomb space warp 
is used to specify the number of frame at which the explosion will start?

		  (a) Start Time	 			   (b) Range
		  (c) Duration				    (d) Strength

5.	 The Wind space warp is used to explode a particle system. (T/F)

6.	 The Mesher compound object is used to create instances of the animated objects. (T/F)

7.	 The PCloud particle system is used to create the particles that will be enclosed within a 
specific volume. (T/F)

8.	 The __________ particle system is the advanced version of the Snow particle system. 

9.	 The __________ particle system is used to generate the particles from the selected 
geometry.

10.	 The __________space warp is used to generate the effect of blowing wind on a particle 
system.

Answers to Self-Evaluation Test
1. a, 2. d, 3. c, 4. d, 5. F, 6. T, 7. T, 8. metaball, 9. Bind to Space Warp, 10. Super Spray


